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ABSTRAK 

Ketersediaan air pada hakikatnya baik kecil maupun besar memiliki 

suatu dampak yang buruk bagi kehidupan. Banjir merupakan proses terjadi 

luapan air yang melebihi kapasitas rata-rata yang seharusnya terjadi. Hal 

ini bisa diakibatkan oleh beberapa faktor seperti aliran drainase yang 

kurang baik atau beralih fungsi lahan dari resapan menjadi lahan 

pemukiman yang minim resapan. Di Kota Makassar tepatnya di kecamatan 

Rappocini dengan scope area Jalan AP. Pettarani, banjir kerap terjadi 

akibat adanya luapan air berasal drainase yang tidak sanggup lagi 

menampung debit air yang ada. Kondisi ini pada saat hujan dengan 

intensitas tinggi terjadi pada kurun waktu yang tergolong cepat. Namun, 

yang terjadi pada daerah perkotaan adalah kurang tersedianya lahan 

apabila dilakukan penambahan atau ukuran kapasitas drainase. Pada 

dasarnya drainase vertikal bisa diterapkan untuk hal ini dengan konsep 

sumur resapan.  

 Penelitian ini menggunakan metode pengukuran langsung dari 

lapangan yang mengidentifikasi daerah yang terjadi genangan serta 

penyebabnya. Sedangkan data sekunder adalah data curah hujan yang 

dikumpulkan dari laman LAPAN dan data kejadian banjir dari pemkot 

Makassar. Yang kemudian diolah pada software EPA-SWMM. 

 Hasil penelitian menunjukkan bahwa kondisi saluran pada Jalan AP. 

Pettarani tidak efektif dalam mengalirkan debit air hujan yang merupakan 

limpasan dari beberapa subcatchment. Hal ini terbukti dengan banyaknya 

saluran yang mengalami overcapacity, sehingga mengakibatkan banjir 

pada jalan tersebut dan setelah dilakukan analisis hidrolika melalui aplikasi 

EPA-SWMM 5.2 pada kondisi penampang eksisting, saluran sudah tidak 

mampu menampung debit air hujan dengan intensitas curah hujan 262.68 

mm/hari pada kala ulang 2 tahun dan 322.11 mm/hari pada kala ulang 5 

tahun. 

 
Kata Kunci: EPA-SWMM, Banjir 
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BAB 1. PENDAHULUAN 

A. Latar Belakang 

 Saluran drainase adalah salah satu bangunan pelengkap pada ruas 

jalan dalam memenuhi salah satu persyaratan teknis prasarana jalan. 

Saluran drainase jalan raya berfungsi untuk mengalirkan air yang dapat 

mengganggu pengguna jalan, sehingga badan jalan tetap kering. Pada 

umumnya saluran drainase jalan raya adalah saluran terbuka dengan 

menggunakan gaya gravitasi untuk mengalirkan air menuju outlet. Distribusi 

aliran dalam saluran drainase menuju outlet ini mengikuti kontur jalan raya, 

sehingga air permukaan akan lebih mudah mengalir secara gravitasi. 

Semakin berkembangnya suatu daerah, lahan kosong untuk meresapkan 

air secara alami akan semakin berkurang. Permukaan tanah tertutup oleh 

beton dan aspal, hal ini akan menambah kelebihan air yang tidak terbuang. 

Kelebihan air ini jika tidak dapat dialirkan akan menyebabkan genangan. 

Dalam perencanaan saluran drainase harus memperhatikan tata guna 

lahan daerah tangkapan air saluran drainase yang bertujuan menjaga ruas 

jalan tetap kering walaupun terjadi kelebihan air, sehingga air permukaan 

tetap terkontrol dan tidak mengganggu pengguna jalan. Genangan di ruas 

jalan masih sering terjadi di beberapa kota, khususnya kota padat 

penduduk. Genangan di ruas jalan akan mengganggu masyarakat yang 

menggunakan ruas jalan tersebut untuk melakukan aktivitas perekonomian. 

Jika masalah genangan tersebut tidak teratasi, maka dapat memungkinkan 
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terjadi bencana yang lebih besar hingga merugikan masyarakat setempat 

baik harta benda maupun nyawa. Ruas Jalan A.P Pettarani adalah salah 

satu ruas jalan di Kota Makassar yang masih sering mengalami genangan 

akibat saluran drainase yang tidak dapat menampung ataupun mengalirkan 

air permukaan. Berdasarkan permasalahan tersebut, penelitian ini perlu 

dilakukan studi kapasitas saluran drainase Jalan A.P Pettarani pasca 

pembangunan jembatan Layang agar dapat ditentukan solusi penyelesaian 

masalahnya.   

 Berdasar dari latar belakang inilah penulis mengangkat tema 

penelitian “STUDI KAPASITAS SALURAN DRAINASE JALAN AP. 

PETTARANI KOTA MAKASSAR PASCA PEMBANGUNAN JEMBATAN 

LAYANG” 

B. Rumusan Masalah  

 Adapun yang menjadi rumusan masalah pada penelitian ini adalah :  

1. Bagaimana efektivitas saluran drainase pada Jalan AP. Pettarani kota 

Makassar dalam mengalirkan debit air? 

2. Bagaimana kapasitas debit air yang dapat dialirkan oleh saluran drainase 

pada Jalan AP. Pettarani kota Makassar? 
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C. Tujuan Penelitian  

 Adapun yang menjadi tujuan penelitian ini adalah :  

1.  Untuk mengetahui efektivitas saluran drainase pada Jalan AP. Pettarani 

kota Makassar dalam mengalirkan debit air 

2. Untuk menghitung kapasitas debit air yang dapat dialirkan oleh saluran 

drainase pada Jalan AP. Pettarani kota Makassar. 

D.  Manfaaat Penelitian  

 Hasil dari penelitian ini diharapkan dapat memberikan manfaat untuk 

masyarakat maupun bidang terkait, sebagai berikut :  

1. Memberikan informasi kepada pihak terkait dalam hal ini pemerintahan 

setempat mengenai kondisi jaringan drainase yang ada saat penelitian.  

2. Sebagai kajian untuk mnegetahui kapasitas debit banjir drainase 

kecematan Rappocini yang nantinya sebagai bahan pertimbangan 

perencenaan ulang drainase.  

3. Sebagai acuan bagi penelitian lanjutan mengenai sistem drainase jalan 

pada lingkup perkotaan.  

4. Memberikan informasi terbaru bagi mahasiswa/i Fakultas Teknik Jurusan 

Teknik Sipil, Universitas Hasanuddin Makassar.  

E. Batasan Masalah  

 Batasan masalah dalam penelitian ini adalah :  
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1. Data curah yang digunakan dari stasiun data curah hujan yang terdekat 

dengan lokasi studi penelitian.  

2. Analisis saluran drainase hanya menghitung kapasitas debit banjir dan 

dimensi saluran drainase.  

3. Lokasi penelitian hanya pada saluran drainase pada Kecematan 

Rappocini Kota Makassar.  

 

F. Sistematika Penulisan 

Adapun sistematika penulisan tugas akhir ini terdiri dari beberapa 

bab sebagai berikut : 

BAB 1. Pendahuluan 

Pendahuluan memuat suatu gambaran secara singkat dan jelas 

tentang latar belakang mengapa penelitian ini perlu dilaksanakan. Dalam 

pendahuluan ini juga memuat rumusan masalah, tujuan penelitian, manfaat 

penelitian, batasan masalah, dan sistematika penulisan tugas akhir ini.  

BAB 2. Tinjauan Pustaka 

 Dalam bab ini berisi mengenai teori-teori yang relevan dengan topik 

permasalahan yang dijadikan sebagai landasan atau acuan dalam 

melakukan penelitian dan memberikan gambaran mengenai metode 

pemecahan masalah yang akan digunakan pada penelitian ini.  

BAB 3. Metode Penelitian  
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 Bab ini membahas mengenai metode yang digunakan dalam 

penelitian ini, meliputi prosedur penelitian yang dituangkan dalam bentuk 

bagan alir penelitian, lokasi dan waktu penelitian, alat dan bahan yang 

digunakan dalam penelitian, jenis dan dan sumber data serta analisis yang 

digunakan dalam mengolah data. 

BAB 4. Hasil Dan Pembahasan 

 Dalam bab ini memuat hasil-hsil pengujian serta analisa data 

perhitungan menggunakan rumus-rumus empiris diantaranya adalah  

BAB 5. Kesimpulan Dan Saran 

Bab ini merupakan penutup dari penulisan tugas akhir yang memuat 

kesimpulan hasil dari analisis penelitian yang disertai dengan saran-saran 

mengenai keseluruhan penelitian maupun untuk penelitian yang akan 

datang.  
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BAB 2. TINJAUAN PUSTAKA 

A. Drainase 

Menurut Gunadarma (2007:1) Ilmu drainase perkotaan bermula 

tumbuh dari kemampuan manusia mengenali lembah-lembah sungai yang 

mampu mendukung air bagi keperluan rumah tangga, pertanian, 

peternakan, perikanan, transportasi dan kebutuhan sosial budaya. 

Drainase (drainage) adalah kata yang berasal dari kata kerja ‘to 

drain’ yang berarti mengeringkan atau mengalirkan air. Itu adalah 

terminologi yang digunakan untuk menyatakan sistem-sistem yang 

berkaitan dengan penanganan masalah kelebihan air, baik di atas maupun 

di bawah permukaan tanah. 

Menurut Halim Hasmar (2012;1), drainase secara umum 

didefenisikan sebagai ilmu pengetahuan yang memelajari usaha untuk 

mengalirkan air yang berlebihan dalam suatu konteks pemanfaatan 

tertentu. Drainase perkotaan/terapan adalah ilmu drainase yang diterapkan 

untuk mengkhususkan pengkajian pada kawasan perkotaan yang erat 

kaitannya dengan kondisi lingkungan sosial budaya yang ada pada 

kawasan kota. Drainase perkotaan/terapan merupakan sistem pengeringan 

dan pengaliran air dari wilayah perkotaan yang meliputi: pemukiman, 

kawasan industri dan perdagangan, kampus dan sekolah, rumah sakit dan 

fasilitas umum, lapangan olahraga, lapangan parkir, instalasi militer, listrik, 

telekomunikasi, dan pelabuhan udara. 
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A.1  Fungsi Drainase 

 Di dalam buku “Penataan Drainase Perkotaan”, Mulyanto (2013) 

menyebutkan bahwa fungsi drainase adalah sebagai berikut : 

1. Membuang air lebih 

 Fungsi ini berjalan dengan mengalirkan air lebih ke tujuan akhirnya, 

yaitu perairan bebas yang dapat berupa sungai, danau, maupun 

laut. Ini merupakan fungsi utama untuk mencegah menggenangnya 

air pada lahan perkotaan maupun di dalam parit-parit. 

2. Mengangkut limbah dan mencuci polusi dari daerah perkotaan 

 Di atas lahan perkotaan tertumpuk bahan polutan berupa debu dan 

sampah organik yang berpotensi mencemari lingkungan hidup. 

Oleh air hujan yang jatuh, polutan akan terbawa ke dalam sistem 

drainase dan dialirkan pergi sambil dinetralisir secara alami. Secara 

alami suatu badan air seperti sungai, saluran drainase mempunyai 

kemampuan untuk menetralisasi cemaran yang memasuki/terbawa 

alirannya dalam jumlah terbatas menjadi zat-zat anorganik yang 

tidak berbahaya atau tidak mencemari lingkungan. 

3. Mengatur Arah dan kecepatan aliran 

 Air buangan berupa air hujan dan limbah harus diatur aliranna 

melewati sistem drainase dan diarahkan ke tempat penampungan 

akhir atau perairan beban di mana sistem bermuara. Arah aliran 

akan ditentukan melewati sistem drainase sehingga tidak 

menimbulkan kekumuhan. Di samping itu, kecepatan alirannya 



8 

 

 

 

 

dapat diatur sebaik mungkin sehingga tidak akan terjadi 

penggerusan atau pengendapan pada saluran-saluran drainase. 

4. Mengatur elevasi muka air tanah 

 Pada kondisi muka air tanah dangkal, daya serap lahan terhadap 

hujan kecil dan dapat menambah potensi banjir. Muka air tanah 

yang dalam akan menyulitkan tetumbuhan penghijauan kota untuk 

menyerapnya khususnya pada musim kemarau tetapi daya serap 

terhadap hujan tinggi. Di samping itu, jika terjadi penurunan air 

maka air tanah akan terjadi pemadatan atau subsidensi : 

penurunan muka tanah di atas muka air tanah. Pemadatan ini 

disebabkan ruang antar butir dalam tanah yang tadinya terisi air 

akan menjadi kosong sehingga tanah memadat. 

5. Menjadi sumber daya air alternatif 

 Makin bertambahnya kebutuhan akan air makin dibutuhkannya 

sumber daya air. Daur ulang air dari sistem drainase dapat menjadi 

alternatif pemenuhan akan sumber daya air dengan beberapa 

syarat. 

A.2  Jenis-Jenis Drainase 

a. Menurut cara terbentuknya 

1) Drainase Alami 

 Saluran ini terbentuk secara alami, tidak ada unsur campur 

tangan manusia serta tidak terdapat bangunan-bangunan 

pelimpah, pasangan batu/beton, gorong-gorong dan lain-lain. 
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2) Drainase Buatan 

 Terbentuk atas keahlian drainase. Dibuat guna menentukan 

debit akibat hujan, cepat atau lambatnya resapan air dalam tanah 

serta dimensi saluran. Saluran ini dapat berfungsi atau 

memerlukan bangunan-bangunan khusus seperti selokan 

pasangan batu/beton, gorong-gorong, pipa-pipa dan sebagainya. 

b. Menurut Letak Saluran 

1) Drainase Muka Tanah 

Saluran drainase yang berada di atas permukaan tanah yang 

berfungsi mengalirkan air limpasan permukaan. 

2) Drainase bawah tanah 

Saluran drainase bawah tanah ini berguna untuk mengalirkan 

air limpasan dari area permukaan menggunakan saluran yang 

berada di bawah permukaan tanah, dikarenakan alasan-alasan 

tertentu. Beberapa alasan itu itu antara lain: tuntutan artistik 

dan estetika, permukaan tanah yang tidak membolehkan 

adanya saluran di premukaan tanah seperti lapangan 

sepakbola, taman dan lain-lain. 

 

 

c. Menurut Fungsi 

1) Single Purpose 
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Saluran berfungsi mengalirkan satu jenis air buangan saja, 

misalnya air hujan atau jenis air buangan seperti air limbah 

domestik, air limbah industri dan lain-lain. 

2) Multi Purpose 

Saluran berfungsi mengalirkan beberapa jenis buangan, baik 

secara bercampur maupun bergantian 

d. Menurut Konstruksi 

1) Saluran terbuka 

Saluran untuk air hujan yang terletak di area yang cukup luas. 

Juga untuk saluran air non hujan yang tidak mengganggu 

kesehatan lingkungan. 

2) Saluran tertutup 

Saluran air untuk air kotor yang mengganggu kesehatan 

lingkungan. Juga untuk saluran dalam kota. 

B.  Genangan 

Genangan menurut Kamus Besar Bahasa Indonesia (Poerwadarminta, 

1990:313), berasal dari kata “genang” yang artinya terhenti mengalir. 

Sehingga, pengertian genangan air adalah air yang berhenti mengalir pada 

suatu area tertentu yang bukan merupakan badan air atau tempat air. 

Tetapi, masyarakat secara umum memahami bahwa baik genangan 

maupun banjir merupakan istilah yang sama. Mereka akrab menyebutnya 
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sebagai banjir. Banjir adalah kumpulan air yang mengalir dengan kecepatan 

tertentu dalam suatu penampang. 

Genangan adalah peristiwa manakala kawasan dipenuhi air karena 

tidak ada drainase yang mematus air tersebut keluar kawasan 

(Sobirin,2007). Sebab itu, genangan memiliki kaitan erat dengan drainase. 

Genangan didefinisikan pula sebagai kumpulan air yang berhenti mengalir 

di tempat-tempat yang tidak termasuk dari badan air. Oleh sebagian 

pengamat perkotaan dan lingkungan, genangan dicurigai muncul sebagai 

dampak dari konflik kepentingan antara air dan manusia. Tarik menarik itu 

dapat disaksikan secara nyata melalui konflik antara daratan yang 

dibanguni dan ruang terbuka hijau; antara ruang bangunan dan tata ruang 

air, serta antara penataan ruang wilayah kota dan pengelolaan sumber 

daya air. 

Rachmat Fajar Lubis pada Juni 2006 dalam Majalah Inovasi Online 

ISSN: 0917-8376 Vol. 7, menulis bahwa Air merupakan salah satu 

parameter kendali dalam tata ruang. Pengembangan tata ruang sangat 

berdampak terhadap siklus air yang ada di suatu wilayah sungai. Siklus air 

tersebut maksudnya adalah siklus hidrologi, yaitu siklus keseimbangan 

antara air hujan, air permukaan, dan air bawah tanah (air tanah). Air yang 

harusnya meresap sebagai infltrasi dan menjadi imbuhan bagi air tanah bila 

terhalang akan berakibat meningkatnya aliran permukaan dan 

menyebabkan genangan air bila tidak diarahkan masuk ke badan air. 
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C.  Analisa Hidrologi 

 Analisa hidrologi ialah sebuah langkah awal dalam menganalisis 

cara penanganan banjir atau genangan, serta perencanaan sistem 

drainase untuk mengetahui seberapa besar debit yang akan dialirkan. Data 

itu yang kemudian hari digunakan untuk menentukan besar dimensi 

saluran. Besarnya debit yang dipakai sebagai dasar perencanaan dalam 

penanggulangan banjir adalah debit rancangan yang didapat dari 

penjumlahan debit hujan rencana pada periode ulang tertentu dengan debit 

air buangan dari daerah tersebut. 

 

Gambar 1. Penampang Saluran Persegi 

 Hidrologi adalah suatu ilmu yang menjelaskan tentang kehadiran dan 

gerakan air di alam kita ini. Ini meliputi berbagai bentuk air, yang 

menyangkut perubahanperubahannya antara keadaan cair, padat dan gas 

dalam atmosfer, di atas dan di bawah permukaan tanah. Di dalamnya 

tercakup pula air laut yang merupakan sumber dan penyimpanan air yang 

mengaktifkan penghidupan di planet bumi ini (Soemarto,1986:15) 
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C.1.  Perhitungan Hujan Wilayah 

 Dalam siklus hidrologi, kami mengolah data menggunakan metode 

Poligon Thiessen. Metode ini memperhitungkan bobot dari masing-masing 

stasiun yang mewakili luasan di sekitarnya. Pada suatu luasan di dalam 

DAS dianggap bahwa hujan adalah sama dengan yang terjadi pada stasiun 

yang terdekat,  sehingga  hujan yang tercatat pada suatu stasiun mewakili 

luasan tersebut. Metode ini digunakan apabila penyebaran stasiun   hujan 

di daerah yang ditinjau tidak merata, pada metode ini stasium hujan minimal 

yang digunakan untuk perhitungan adalah tiga stasiun hujan. Hitungan 

curah hujan rata-rata dilakukan dengan memperhitungkan daerah 

pengaruh dari tiap stasiun. 

 Metode poligon Thiessen banyak digunakan untuk menghitung hujan 

rata-rata kawasan. Poligon Thiessen adalah tetap untuk suatu jaringan 

stasiun hujan tertentu. Apabila   terdapat   perubahan   jaringan   stasiun   

hujan   seperti   pemindahan   atau penambahan stasiun, maka harus dibuat 

lagi poligon yang baru (Triatmodjo, 2008). 

 

Gambar 2. Poligon Thiessen 
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Metode Poligon Thiessen dapat dilakukan dengan mengikuti langkah 

berikut: 

1. Stasiun pengamat digambar pada peta, dan ditarik garis hubung 

masing-masing stasiun. 

2. Garis bagi tegak lurus dari garis hubung tersebut membentuk 

poligon-poligon mengelilingi tiap–tiap stasiun, dan hindari bentuk 

poligon segitiga tumpul. 

3. Sisi tiap poligon merupakan batas-batas daerah pengamat yang 

bersangkutan. 

4. Hitung luas tiap poligon yang terdapat di dalam DAS dan luas DAS 

seluruhnya dengan planimeter dan luas tiap poligon dinyatakan 

sebagai persentase dari luas DAS seluruhnya. Selain itu, 

menghitung luas juga bisa menggunakan  kertas milimeter blok. 

5. Faktor bobot dalam menghitung hujan rata–rata daerah di dapat 

dengan mengalikan hujan rata–rata area yang didapat dengan 

mengalikan presipitasi tiap stasiun pengamat dikalikan dengan 

persentase luas daerah yang bersangkutan.  

R =
𝐴1R1+𝐴2𝑅2+⋯+𝐴𝑛 𝑅𝑛

𝐴1+𝐴2+⋯+𝐴𝑛
  

 (1) 

Keterangan : 

R        = curah hujan daerah (mm) 

n       = jumlah titik–titik (pos) pengamatan 

R1, R 2,..... ,Rn     = curah hujan ditiap titik pengamatan (mm) 
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A1, A 2,..... ,An     = bagian daerah yang mewakili tiap titik pengamatan (km2) 

C.2.  Analisis Curah Hujan Maksimum 

 Tujuan analisis frekuensi data hidrologi adalah berkaitan dengan 

besaran peristiwa-peristiwa ekstrim yang berkaitan dengan frekuensi 

kejadiannya melalui penerapan distribusi kemungkinan. Data hidrologi yang 

dianalisis diasumsikan tidak bergantung dan terdistribusi secara acak dan 

bersifat stokastik (Suripin, 2004). 

 Analisa curah hujan maksimum didapatkan melalui mengumpulkan 

data hasil olahan menggunakan metode Poligon Thiessen dan Aljabar, 

kemudian mencari hujan harian maksimal, menyesuaikan tanggal dan 

intensitas curah hujannya lalu kemudian dirata-ratakan.  

𝑥 =
1

𝑛
∑ X𝑛

𝑖=1 𝑖                         (2) 

Keterangan: 

X = Curah hujan maksimum harian rata-rata 

n = Banyaknya jumlah data 

∑Xi = Jumlah seluruh curah hujan maksimum harian per stasiun 

C.3.  Analisis Curah Hujan Rencana 

 Di dalam perhitungan curah hujan rancangan, dapat digunakan 

analisa frekuensi. Suripin (2003) dalam Sistem Drainase Perkotaan yang 

Berkelanjutan menyatakan bahwa Frekuensi adalah besarnya 

kemungkinan suatu besaran hujan disamai atau dilampaui. Sebaliknya, 

kala ulang (return) periode adalah waktu hipotetik dimana hujan dengan 

suatu besaran tertentu akan disamai atau dilampaui. 
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 Dalam menghitung analisa frekuensi, maka dapat digunakan 

metode-metode berikut Log Pearson Tipe III (CD.Soemarto, 1999) : 

Log XT  = xlog  + KT Sd (3) 

Sd  = 


n

1  i

2

1 -n  

)x log -  xilog (

 

(4) 

 xlog   = 


n

1  i n

 xilog

 

(5) 

Cs  = 
 Sd ) 2 -n  ( ) 1 -n  (

) xlog -  xilog (n 

3

n

1  i

3


 

(6) 

Keterangan:  

KT =  koefisien penambahan karena faktor kemencengan 

Log XT =  logaritma curah hujan maksimal untuk periode ulang T 

Log X =  logaritma rata–rata curah hujan 

Sd =  standar deviasi 

Cs =  koesfisien kemencengan distribusi data 

C.4.  Pengukuran Dispersi 

 Suatu kenyataan bahwa tidak semua variat dari suatu variabel 

hidrologi terletak atau sama dengan nilai rata-ratanya, kemungkinan ada 

nilai variat yang lebih besar atau lebih kecil dari pada nilai rata-ratanya. 

Besarnya derajat dari sebaran variat di sekitar nilai rata-ratanya disebut 

dengan variasi (variation) atau dispersi (dispersion). 
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 Cara mengukur besarnya variasi atau dispersi disebut pengukuran 

dispersi. Pengukuran ini meliputi  standar  deviasi,  koefisien kemencengan, 

koefisien variasi, dan pengukuran kurtosis. 

       𝑠 = [
∑ (𝑋𝑖−𝑋𝑟𝑡)2𝑛

𝐼=0

𝑛−1
]

0.5

       (7) 

𝐶𝑣 =
𝑆

Xrt
         (8) 

𝐶𝑠 =
𝑛 ∑  = 𝑛

𝑖 1 (𝑋𝑖−𝑋𝑟𝑡)3

(n−1)(n−2)𝑆3
       (9) 

𝐶𝑘 =
𝑛2 ∑ {log(𝑋𝑖)−log 𝑋𝑟𝑡}4𝑛

𝑖=1

(𝑛−1)(𝑛−2)(𝑛−3)𝑆4
      (10) 

Keterangan: 

S =  standar deviasi. 

Xi =  titik tengah tiap interval kelas (mm). 

Xrt =  rata-rata hitungan (mm). 

n =  jumlah kelas 

Cv  = Koefisien Variasi. 

Cs = Keofisien Kemencengan 

Ck  = Koefisien Kurtosis 

C.5  Uji Chi-Kuadrat 

 Uji chi kuadrat dimaksudkan untuk menentukan apakah persamaan 

distribusi peluang yang telah dipilih dapat mewakili dari distribusi statistik 

sampel data yang dianalisa atau dengan kata lain apakah distribusi yang 

telah dipilih benar atau dapat digunakan untuk menghitung sampel data. 
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Pengambilan keputusan uji ini menggunakan parameter X2h, oleh karena 

itu disebut uji chi-kuadrat. (Suripin,2004). 

𝑋2 = ∑
(𝑂𝑖−𝐸𝑖)2

𝐸𝑖

𝑛
𝑖=1             (11) 

Keterangan: 

X2 = Harga chi-kuadrat terhitung 

Oi = Jumlah nilai pengamatan pada sub kelompok ke-1 

Ei = Jumlah nilai teoritas pada sub kelompok ke-1 

n = Jumlah data.  

C.6  Perhitungan Debit Aliran 

 Debit aliran ialah satuan guna mendekati nilai-nilai hidrologis proses 

yang terjadi di lapangan. Ilmu pengukuran debit aliran diperlukan untuk 

mengetahui potensi sumberdaya air di wilayah DAS tertentu. Debit aliran 

bisa dijadikan alat untuk MonEv (Monitoring dan Evaluasi) neraca air suatu 

kawasan dengan pendekatan potensi sumber day aair di permukaan yang 

ada. 

 Ini memberikan gambaran kepada kita tentang berbagai metode dan 

teknik pengukuran debit aliran dengan berbagai peralatan yang diperlukan. 

Pemahaman terhadap metode pengukuran debit aliran dapat jadi bekal 

untuk melakukan pengukuran-pengukuran potensi air permukaan yang 

dapat bermanfaat dalam pengelolaan sumberdaya air. 

Faktor-faktor untuk menentukan debit aliran, yaitu (SNI 03-3424, 1994:12) 

a. Intensitas Curah Hujan 
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 Intensitas curah hujan (I) adalah rata-rata dari hujan yang durasinya 

sama dengan waktu konsentrasi (tc) dengan masa ulang tertentu. 

Hubungan antara intensitas curah hujan dengan lama hujan 

berlangsung, digunakan rumus berikut (Suripin, 2004:68) : 

 Rumus Mononobe  

𝐼 =
𝑅24

24
(

24

𝑡𝑐
)

2

3
            (12) 

Keterangan:  

I = intensitas hujan (mm/jam) 

R24 = curah hujan maksimun harian (selama 24 jam) (mm) 

tc = Waktu konsentrasi (jam) 

 

Untuk menentukan waktu Konsentrasi (tc), digunakan Rumus Kirpich: 

𝑡𝑐 =
0.87𝑥 𝐿2

1000 𝑥 𝑆
            (13) 

tc  = Waktu konsentrasi (jam) 

L = panjang lintasan air dari titik terjauh sampai titik yang ditinjau(Km) 

S = kemiringan rata-rata daerah lintasan 

Waktu konsentrasi aliran adalah waktu yang dibutuhkan air hujan yang 

jatuh diseluruh daerah tangkapan untuk mengalir ketitik yang ditinjau, 

(SNI, 1994:17). 

Waktu konsentrasi dihitung dengan rumus: tc = t1 + t2 

𝑡2 =
𝐿

60𝑥𝑉
       (14) 

Keterangan : 
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t1 = Waktu untuk mencapai awal saluran (menit) 

t2 = Waktu pengaliran (menit) tc = waktu konsentrasi (jam) 

nd  = Koefisien hambatan (Tabel 2.19) 

Lo  = Jarak aliran dari titik terjauh sampai sarana drainase 

L = Panjang saluran yang ditinjau (m)  

S = Kemiringan daerah pengaliran 

V  = Kecepatan pengaliran (m/dtk) 

b. Luas Penampang Saluran 

Untuk menghitung luas penampang saluran menggunakan rumus 

sebagai berikut : 

 𝐴 =
𝑄

𝑉
        (15) 

Keterangan:  

Q = Debit saluran (m3) 

A = Luas penampang saluran (m2)  

V = Kecepatan aliran ( m/det ) 

Menghitung dimensi penampang berbentuk trapesium : 

𝐴 =
(𝑏 +  𝑚ℎ)

ℎ
 

𝑃 = 𝑏 + 2ℎ √1 + 𝑚2 

𝑅 =
𝐴

𝑃
 

Keterangan: 

A = Luas penampang basah saluran ( m2 ) 
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P = Keliling penampang basah saluran(m)  

R = Jari-jari hidrolis ( m ) 

h = Tinggi air dalam saluran (m )  

b = Lebar dasar saluran ( m ) 

m = Kemiringan dinding saluran 

D. Analisa Hidrolika 

 Mempertimbangkan kapasitas tampungan saluran wajib dilakukan 

ketika mencoba merencanakan saluran drainase, baik tinjauan hidrolis 

maupun elevasi kondisi lapangan. 

 Studi hidrolis ini bertujuan untuk menghitung elevasi kapasitas 

tampungan saluran debit banjir ulang selama 10 tahun. Pengukuran kondisi 

lapangan adalah didasarkan pengamatan secara langsung di lapangan 

agar diketahui bahwa saluran yang ada mampu mengalirkan air secara 

clear saat terjadi hujan. Rumus kecepatan rata-rata pada perhitungan 

dimensi saluran menggunakan rumus Manning: 

 

   V = 
1

n
R

2

3S
1

2       (17) 

Keterangan: 

V = kecepatan rata-rata (m/dt) 

n = koef. Manning 

R = jari-jari hidrolik  

S = kemiringan dari muka air atau gradient energi dari dasar saluran. 
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Tabel 1. Koefisien Manning Untuk Saluran Tertutup 

Material Saluran Manning n 

Asbestos-cement pipe 0.011 - 0.015 

Brick 0.013 - 0.017 

Cast iron pipe  

-Cement-lined & seal coated 0.011 - 0.015 

Concrete  

-Smooth forms 0.012 - 0.014 

-Rough forms 0.015  0.017 

Concrete pipe 0.011 - 0.015 

Corrugated-metal-pipe 

(1/2-in. X 2-2/3-in. Corrugations) 

 

-Plain 0.022 - 0.026 

-Paved invert 0.018 – 0.022 

-Spun asphalt lined 0.011 – 0.015 

Plastic pipe (smooth) 0.011 – 0.015 

Vitrified clay  

-Pipes 0.011 – 0.015 

-Liner plates 0.013 – 0.017 
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Tabel 2. Koefisien Manning Untuk Overland Flow 

Material Saluran Manning n 

Smooth Asphalt 0.011 

Smooth Concrete 0.012 

Ordinary concrete lining 0.013 

Good Wood 0.014 

Brick with cement mortar 0.014 

Vitrified clay 0.015 

Cast iron 0.015 

Corrugated metal pipes 0.024 

Cement rubble surface 0.024 

Fallow soils (no residue) 0.05 

Cultivated soils  

Residue Cover <20% 0.06 

Residue cover >20% 0.017 

Range (natural) 0.013 

Grass  

Short, prarie 0.15 

Dense 0.24 

Bermuda Grass 0.41 

Woods  

Light underbrush 0.60 

Dense underbrush 0.80 

 

E.  Aplikasi EPA-SWMM 5.2 

 Studi Hidrolika ini dijalankan dengan menggunakan aplikasi EPA-

SWMM 5.2 (Enviromental Protection Agency- Storm Water Management 
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Model). Aplikasi ini ialah aplikasi yang dikembangkan untuk simulasi proses 

hidrologi dan hidrolika di wilayah perkotaan. Biasa digunakan untuk simulasi 

limpasan dan uji kelayakan drainase dalam rentang waktu yang terus 

menerus atau kejadian banjir sesaat. 

 Dalam aplikasi EPA-SWMM 5.2, ada beberapa komponen data yang 

harus dimasukkan agar program ini dapat dijalankan.  

 

Gambar 3. Legenda EPA-SWMM 5.2 

1. Rain gages (Curah Hujan) 

 Curah hujan adalah jumlah air hujan yang jatuh selama periode 

waktu tertentu yang pengukurannya menggunakan satuan tinggi di atas 

permukaan tanah horizontal yang diasumsikan tidak terjadi infiltrasi, run off, 

maupun evaporasi. 

 Definisi curah hujan atau yang sering disebut presipitasi dapat 

diartikan jumlah air hujan yang turun di daerah tertentu dalam satuan waktu 

tertentu. Jumlah curah hujan merupakan volume air yang terkumpul di 

permukaan bidang datar dalam suatu periode tertentu (harian, mingguan, 

bulanan, atau tahunan). 

 Curah hujan merupakan jumlah air yang jatuh di permukaan tanah 

datar selama periode tertentu yang diukur dengan satuan tinggi milimeter 

(mm) di atas permukaan horizontal. Hujan juga dapat diartikan sebagai 

ketinggian air hujan yang terkumpul dalam tempat yang datar, tidak 

menguap, tidak meresap dan tidak mengalir (Suroso 2006). 
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2. Subcatchment (Daerah Tangkapan Hujan)  

 Daerah tangkapan hujan merupakan suatu wilayah daratan yang 

merupakan satu kesatuan dengan sungai dan anak-anak sungainya, yang 

berfungsi menampung, menyimpan, dan mengalirkan air yang berasal dari 

curah hujan ke danau atau ke laut secara alami, yang batas di darat 

merupakan pemisah topografis yang dapat berupa punggung-punggung 

bukit atau  gunung dan batas di laut sampai dengan daerah perairan yang 

masih terpengaruh aktivitas daratan. 

 Daerah aliran sungai, suatu kawasan berupa cekungan yang dibatasi 

oleh pembatas topografi berupa igir yang didalamnya terdapat jaringan 

sungai, dimana hujan yang jatuh kedalam kawasan ini dikeluarkan melalui 

satu keluaran (outlet) (Linsley et al,1975).  

3. Junction (Titik pertemuan air) 

 Junction adalah lokasi yang menjadi titik pertemuan antara saluran 

satu dengan jaringan-jaringan yang lain. Dapat berupa manhole ataupun 

hanya titik tempat mengalirnya air dari suatu subcatchment. 

4. Conduit (Drainase) 

 Conduit adalah bahasa yang digunakan aplikasi EPA-SWMM dalam 

menjelaskan drainase. Dalam EPA-SWMM,  titik-titik berupa Junction 

dihubungkan oleh garis yang disebut Conduit. Conduit ini kemudian 
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dilengkapi dengan data yang telah diinput berdasarkan kondisi ril di 

lapangan. 

 Untuk menjalankan conduit sebagaimana mestinya, conduit ini mesti 

dihubungkan dengan manhole berdasarkan hulu dan hilirnya. 

5. Outfall (Jalur keluar) 

 Outfall adalah titik tempat keluarnya air dari rangkaian yang telah 

dibuat di aplikasi EPA-SWMM. Ini adalah titik hilir. Oleh karena itu, Outfall 

ini adalah titik dengan elevasi terendah di dalam aplikasi. 

F. Pengoperasian Aplikasi EPA-SWMM 5.2 

1. Open software SWMM 5.2. 

2. File > New. 

3. Lalu setting dahulu Project Default dengan cara: 

a. Project > Default 

 

Gambar 4. Tutorial EPA-SWMM 5.2 
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b. Isi tabs ID Labels sebagai berikut: 

 

Gambar 5. Tutorial EPA-SWMM 5.2 

 

c. Isi tabs Substachments seperti berikut: 

 

Gambar 6. Tutorial EPA-SWMM 5.2 
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d. Pada baris infiltration model klik tabs titik tiga 

e. Lalu pilih MODIFIED_GREEN_AMPT dengan input value 

sebagai berikut: 

 

Gambar 7. Tutorial EPA-SWMM 5.2 

f. Isi tabs Nodes/Links seperti berikut: 

 

Gambar 8. Tutorial EPA-SWMM 5.2 
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g. Pada Conduit Geometri pilih bentuk saluran dan tentukan 

dimensi saluran : 

 

Gambar 9. Tutorial EPA-SWMM 5.2 

 

h. Jika ingin menjadikan default untuk project berikutnya, 

centang box set as default for all new project 

i. Click OK. 

4. Setting map Display agar ID Labels dan symbols yang akan muncul 

Ketika add object ke study area akan muncul arah panah, dengan 

cara sebagai berikut: 

a. Tools > Map Display Option. 

 

Gambar 10. Tutorial EPA-SWMM 5.2 
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b. Pada tabs Subcatchments, pilih Fill Style Diagonal dan 

Symbol Size 5. 

 

Gambar 11. Tutorial EPA-SWMM 5.2 

c. Pada tabs nodes, atur Nodes Size ke 5. 

 

Gambar 12. Tutorial EPA-SWMM 5.2 
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d. Pada tabs Annotation, check list box Subscatch IDs, Node 

IDs, Link IDs dan biarkan yang lain. Dengan tujuan untuk 

memunculkan nama-nama Object. 

 

Gambar 13. Tutorial EPA-SWMM 5.2 

e. Pada tabs Flow Arrows, pilih Filled pada kolom Arrow Style 

dan set Arrow Size ke 7. 

 

Gambar 14. Tutorial EPA-SWMM 5.2 

f. Click OK. 
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5. Sebelum meletakkan object pada map, kita harus mengatur 

dimensinya dengan cara: 

a. View > Dimensions 

 

Gambar 15. Tutorial EPA-SWMM 5.2 

b. Untuk Latihan ini, biarkan saja dalam bentuk default. 

 

Gambar 16. Tutorial EPA-SWMM 5.2 

c. Perhatikan pada status bar pada bagian bawah kiri, pastikan 

Auto – length dalam keadaan OFF (tanpa ukuran). 
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Gambar 17. Tutorial EPA-SWMM 5.2 

d. Perhatikan pada status bar bagian bawah kiri, pastikan juga 

untuk men-setting Offsets menjadi Depth dan Flow Units 

menjadi CMS (Cubic Meter per Second).  

 

 

 

 

Gambar 18. Tutorial EPA-SWMM 5.2 
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6. Memulai menggambar Object 

a. Pilih substachments pada sub menu Hydrology. 

   

Gambar 19. Tutorial EPA-SWMM 5.2 

Atau dengan memilih icon “Add a Substachment” yang 

berbentuk persegi. 

 

Gambar 20. Tutorial EPA-SWMM 5.2 

b. Arahkan mouse ke Study Map Area lalu klik kiri pada suatu 

titik dan lanjutkan ke titik selanjutnya sampai membentuk 

persegi, saat akan menggabungkan garis putus-putus akhiri 

dengan klik kanan. 
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Gambar 21. Tutorial EPA-SWMM 5.2 

7. Setting object properties. 

 

Gambar 22. Tutorial EPA-SWMM 5.2 

8. Untuk menge-check object properties bisa dilakukan dengan klik 

kanan lalu pilih Properties. 
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Gambar 23. Tutorial EPA-SWMM 5.2 

a. Langkah selanjutnya, pada main menu ambil tabs Edit > 

Select All. 

 

Gambar 24. Tutorial EPA-SWMM 5.2 

b. Selanjutnya ambil kembali tabs edit > group edit, maka akan 

terbuka windows seperti dibawah ini. Pilih subcatchment pada 

for object of type, pilih rain gages pada edit the property dan 
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isikan RG1 pada by replacing it with. Disesuaikan dengan 

penanaman pada Rain gages yang telah dibuat sebelumnya. 

 

Gambar 25. Tutorial EPA-SWMM 5.2 

 

c. Jika sudah klik OK, maka akan keluar windows konfirmasi pilih 

“NO”. Tutup kembali group editor. 
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Gambar 26. Tutorial EPA-SWMM 5.2 

d. Untuk menentukan outlet node pada Subcatchment harus 

dilakukan satu persatu, dengan cara memunculkan properties 

pada Subcacthmens C1. Lalu pada baris outlet isikan J1. 

 

Gambar 27. Tutorial EPA-SWMM 5.2 

e. Sehingga pada study area map terbentuk seperti ini: 
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Gambar 28. Tutorial EPA-SWMM 5.2 

f. Lanjutkan untuk seluruh Substachments, sehingga setiap 

Subcatchments dapat terhubung ke masing-masing junction 

menjadi seperti ini: 

 

Gambar 29. Tutorial EPA-SWMM 5.2 
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g. Pada penilitian ini kita menginginkan area C3 kurang 

berkembang dari pada yang lainnya, maka pada properties 

editor lalu ganti % Imperv ke 25. 

 

Gambar 30. Tutorial EPA-SWMM 5.2 

 

h. Ubah invert elevation pada node J1, J2, J3 dan J4 menjadi 

seperti berikut. 
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Gambar 31. Tutorial EPA-SWMM 5.2 

i. Ubah invert elevation pada Out1 menjadi seperti berikut: 

 

Gambar 32. Tutorial EPA-SWMM 5.2 

j. Langkah selanjutnya pada Project Browser lalu tambahkan 

Time Series. 
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Gambar 33. Tutorial EPA-SWMM 5.2 

k. Maka akan muncul windows seperti ini. Inputkan Time Series 

name sebagai TS1 dan inputkan kolom time dan kolom value 

seperti ilustrasi dibawah. 

 

Gambar 34. Tutorial EPA-SWMM 5.2 
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l. Klik tombol view untuk melihat grafik dari time series value. 

 

Gambar 35. Tutorial EPA-SWMM 5.2 

 

m. Ubah rain gage’s properties seperti ilustrasi berikut: 

 

Gambar 36. Tutorial EPA-SWMM 5.2 
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n. Langkah selanjutnya adalah memberi judul pada project kali 

ini caranya adalah pada project browser pilih sub menu 

title/notes. 

 

Gambar 37. Tutorial EPA-SWMM 5.2 

o. Maka akan muncul windows titile/notes editor lalu isikan 

dengan “tugas akhir” setelah itu tekan tombol OK. 

 

Gambar 38. Tutorial EPA-SWMM 5.2 
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p. Selanjutnya save pekerjaan dengan cara File > save as dan 

beri nama pekerjaan toturial sehingga menjadi tutorial.inp 

dengan extension dari software SWMM 5.2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


